Trademarks
Any brand or product names are trademarks or registered trademarks of their respective holders.

The Genesis Group Trademark Information
GenWatch3® is a registered trademark of GenCore Candeo, LTD., a subsidiary of Burks GenCore Co., Inc. D.B.A. The Genesis Group and Phil Burks.

Copyright
Copyright © 2006-2020; Burks GenCore Co., Inc. D.B.A. The Genesis Group and Phil Burks. All rights are reserved. No part of this publication or the associated program may be reproduced, transmitted, transcribed, in whole or in part, in any form or by any means, whether it is mechanical, magnetic, optical, electronic, manual or otherwise, without the prior written consent of Burks GenCore Co., Inc. D.B.A: The Genesis Group and Phil Burks
5800 Eagles Nest Blvd
Tyler, Texas 75703.

Includes technology licensed from Motorola.

Disclaimer
The GenWatch3 User’s Manual is printed in the U.S.A. Burks GenCore Co., Inc. D.B.A. The Genesis Group and Phil Burks believe that the information included in this manual is correct; however, Burks GenCore Co., Inc. D.B.A. The Genesis Group and Phil Burks reserves the right to alter, revise and make periodic changes to the manual and its contents. Burks GenCore Co., Inc. D.B.A. The Genesis Group does not assume responsibility to notify any person of such revisions or changes. While we have taken strides to carefully examine our software and documentation and believe that it is reliable, the Genesis Group and Phil Burks assume no responsibility for the use of the manual, or GenWatch3 software, nor for any patent infringements or other rights of third parties who may use the manual or the GenWatch3 software. Burks GenCore Co., Inc. D.B.A. The Genesis Group and Phil Burks make no representations or warranties with respect to the contents or fitness for a particular purpose beyond the cost of the software paid by the end-user.

The software contains valuable trade secrets and proprietary information. Unauthorized use of the manual or software can result in civil damages and criminal prosecution. As an end user, you agree to abide by and heed these statements.

License
Title to the media on which the program is recorded and to the documentation in support of the product is transferred to you, but title to the program, and all subsequent copies of the program, despite the form or media in or on license is not a sale of the original or any subsequent copy. You assume responsibility for the selection of the program to achieve your intended results, and for the installation, use, and results obtained from the program.

Refer to the GenWatch3 Manual Overview for your full license. All license information contained on pages 4-7 (Book 600-2.16.15-AA.1) are to be considered as contained herein.

Support
Customer satisfaction is our number one priority at Genesis. We are here to provide you with the best software possible, and we want to know when you have any questions, concerns or problems with GenWatch3 so that we can make it a better product for everyone.

Refer to the Troubleshooting & Support section of the GenWatch3 Manual Shell (Book 600-2.16.15-AA.1) for complete support and contact information.
## Document History

<table>
<thead>
<tr>
<th>Revision</th>
<th>Description</th>
<th>Author</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.0.2</td>
<td>Initial Release</td>
<td>JAW</td>
</tr>
<tr>
<td>2.0.3</td>
<td>Revisions before Release</td>
<td>JPS</td>
</tr>
<tr>
<td>2.0.4</td>
<td>Changed to reflect new Advanced Filter options</td>
<td>JAW</td>
</tr>
<tr>
<td>2.0.5</td>
<td>Revisions before Release</td>
<td>TDW</td>
</tr>
<tr>
<td>2.0.6</td>
<td>Updated screenshots with F1 help image</td>
<td>REB</td>
</tr>
<tr>
<td>2.0.6.6</td>
<td>Update Activity Values details</td>
<td>CLB</td>
</tr>
<tr>
<td>2.2</td>
<td>Revisions Before release</td>
<td>CWF</td>
</tr>
<tr>
<td>2.3</td>
<td>Revisions Before Release</td>
<td>CWF</td>
</tr>
<tr>
<td>2.4</td>
<td>Revisions Before Release</td>
<td>CWF</td>
</tr>
<tr>
<td>2.5</td>
<td>Revisions Before Release</td>
<td>CWF</td>
</tr>
<tr>
<td>2.5</td>
<td>Added how to delete packet types from the list.</td>
<td>REB</td>
</tr>
<tr>
<td>2.6</td>
<td>Revisions Before Release</td>
<td>CWF</td>
</tr>
<tr>
<td>2.7</td>
<td>Added slot to Ch# column description</td>
<td>KIH</td>
</tr>
<tr>
<td>2.7</td>
<td>Revisions Before Release</td>
<td>JAW</td>
</tr>
<tr>
<td>2.8</td>
<td>Revisions Before Release</td>
<td>ATG</td>
</tr>
<tr>
<td>2.9</td>
<td>Revisions Before Release</td>
<td>REB</td>
</tr>
<tr>
<td>2.10</td>
<td>Revisions Before Release</td>
<td>ATG</td>
</tr>
<tr>
<td>2.11</td>
<td>Converted to Docx format</td>
<td>CWF</td>
</tr>
<tr>
<td>2.12</td>
<td>Revisions Before Release</td>
<td>JAW</td>
</tr>
<tr>
<td>2.13</td>
<td>Revisions Before Release</td>
<td>ATG</td>
</tr>
<tr>
<td>2.14</td>
<td>Revisions Before Release</td>
<td>JAW</td>
</tr>
<tr>
<td>2.15</td>
<td>Revisions Before Release</td>
<td>REB</td>
</tr>
<tr>
<td>2.16</td>
<td>Revisions Before Release</td>
<td>JPS</td>
</tr>
</tbody>
</table>
# Table of Contents

**Trademarks** .......................................................................................................................... 3  
**The Genesis Group Trademark Information** ......................................................................... 3  
**Copyright** .............................................................................................................................. 3  
**Disclaimer** ............................................................................................................................. 3  
**License** .................................................................................................................................. 3  
**Support** .................................................................................................................................. 3  
**DOCUMENT HISTORY** ............................................................................................................. 4  

## TABLE OF CONTENTS ............................................................................................................. 5  

## ABOUT THIS MANUAL .......................................................................................................... 7  
   **Goals** ..................................................................................................................................... 7  
   **Who Should Read This Manual?** .......................................................................................... 7  
   **How This Manual Is Organized** .......................................................................................... 7  

## CHAPTER 1 OVERVIEW ........................................................................................................ 9  
   **What is GW_ACTIVITY?** ........................................................................................................ 10  
   **Monitoring Channel Activity** .............................................................................................. 10  
      **Activity Values** ................................................................................................................ 11  
      **Maximizing the Activity List** ........................................................................................... 13  
   **Customizing Channel Activity** ........................................................................................... 13  
      **Changing Activity List Font and Size** ............................................................................. 13  
      **Enabling/Disabling the Green Bar** .................................................................................. 14  
      **Showing/Hiding Columns** ............................................................................................... 14  
      **Reordering Columns** ....................................................................................................... 15  
      **Adding a Little Color to Your Life** ................................................................................... 15  
      **Disabling Packet Throttling** ............................................................................................ 15  
      **Filtering Packet Types** ..................................................................................................... 15  
      **Selecting All Packet Types** .............................................................................................. 16  
      **Unselecting All Packet Types** ......................................................................................... 16  
      **Deleting Packet Types** ...................................................................................................... 16  
      **Suppressing Duplicate Packets** ...................................................................................... 16  

## CHAPTER 2 ADVANCED OPTIONS .......................................................................................... 17  
   **Advanced Filters** .................................................................................................................. 18  
      **Trunking Filters** ................................................................................................................ 18  
      **System Filter** .................................................................................................................... 18  
      **Group Filter** ..................................................................................................................... 19  
      **Radio ID Filter** .................................................................................................................. 20  
      **Agencies Filter** .................................................................................................................. 20  
   **Pausing the Activity List** ...................................................................................................... 21  
      **Pause Window Options** .................................................................................................... 21  
         **Opacity (available in menu only)** .................................................................................. 22  
         **Print (available in menu and right-click)** ...................................................................... 22  
         **Select All… (available in right-click only)** .................................................................... 22  
   **Activity Details** .................................................................................................................... 23
Goals
This document describes the role and function of the GW_Activity module and GW_Activity GUI (Graphical User Interface) within the GenWatch3 solution.

Who Should Read This Manual?
This document is written for an intended audience of novice to intermediate trunked radio system users and novice to intermediate PC users.

How This Manual Is Organized
This manual is organized as follows:
- **Overview**: Describes the basic function of the GW_Activity module and GUI.
- **Advanced Options**: Describes the function of the advanced GW_Activity options.

This manual contains the following images, used to indicate that a segment of text requires special attention:
- **Additional Information**: Additional information is used to indicate shortcuts or tips.
- **Warning**: Warnings are used to indicate possible problem areas, such as a risk of data loss, or incorrect/unexpected functionality.
Chapter 1

Overview

This chapter defines the GW_Activity module and GW_Activity GUI and gives instructions on filtering and color-coding packets.

This chapter contains the following sections:

- **What is GW_Activity?**: Defines the GW_Activity module and GUI.
- **Monitoring Channel Activity**: Describes how to interpret the data in the activity list.
- **Customizing Channel Activity**: Describes how to customize the GW_Activity GUI.

Figure 1.1 – GW_Activity GUI
What is GW_Activity?

The GW_Activity GUI shows real-time activity from each GenWatch3 input connection. These input connections can vary from single-site connections monitoring a control channel to multisite connections receiving data from a data stream. Through this window you can:

- Monitor channel activity.
- Filter the packet types.
- Assign colors to specific packet types.
- Customize the font and column order of the activity list.
- Suppress duplicate packets.
- Pause the activity list.
- Print the activity list.

Monitoring Channel Activity

The GW_Activity GUI provides the activity list. This list allows you to view control channel or multisite stream activity in real time. For a description of the type of information that can be received for an input type, refer to the module book for the associated input module.

Refer to the Troubleshooting & Support section of the GenWatch3 Manual Shell (Book 600-2.16.15-AA.1) for complete support and contact information.
Activity Values

The activity list contains the following columns:

- **Description**: Broad category of the activity (i.e. Affiliation, Status, Message, etc.).
- **Group**: Target group (if any) of the activity.
- **Group Alias**: Alias of the target group (if there is a group). If the multisite stream includes a group ID alias, this alias will be used. See note on aliases below.
- **ID**: Originating radio ID (if any) of the activity.
- **ID Alias**: Alias of the originating radio ID (if there is a radio ID). If the multisite stream includes a radio ID alias, this alias will be used. See note on aliases below.
- **Type**: Activity subcategory. Further describes the type of activity.
- **Target ID**: This will contain one of the following values, if the value is provided in the packet:
  - **Target Radio ID**: For call alerts, private calls, etc.
  - **Target Supergroup**: For dynamic regrouping.
  - **Diagnostic Condition Description**: For system diagnostics
  - **Message Number**: For messages
  - **Status Number**: For statuses
  - **Reason**: For rejects, corruption, etc.
  - **Longitude**: For GPS Location info
  - **Latitude**: For GPS Location info
- **Target ID Alias**: This will contain one of the following values, if the value is provided in the packet:
  - **Target Radio ID Alias**: For call alerts, private calls, etc. If the multisite stream includes a Target Radio ID Alias, this alias will be used. See note on aliases below.
  - **Target Supergroup Alias**: For dynamic regrouping. If the multisite stream includes a Target Supergroup Alias, this alias will be used. See note on aliases below.
- **Ch. #**: This will contain one of the following values, if the value is provided in the packet:
  - **For Control Channel-based Data**: The Channel Number that the activity took place on. If the activity includes slot data, `<Channel Number>-<Slot Number>` is displayed.
  - **For Multisite Channel Number-based Data**: Comma-separated pairs of `<Site Id>-<Channel Number>` for each site channel included in the activity. If the activity includes slot data, comma-separated pairs of `<Site Id>-<Channel Number>-<Slot Number>` for each site channel slot included in the activity. Busy sites are shown in `B-<site1>,<site2>` format. Incapable sites are shown following in `I-<site1>,<site2>` format. See notes below.
- **Ch. Freq.**: This column will contain the frequency of the channel the activity took place on. For multisite data, this column will be empty.
For Multisite Frequency-based Data: Comma-separated pairs of `<Site Id>`-`<Frequency>` for each site channel included in the activity. If the activity includes slot data, comma-separated pairs of `<Site Id>`-`<Frequency>`-`<Slot Number>` for each site channel slot included in the activity. Busy sites are shown in `B-<site1>,<site2>` format. Incapable sites are shown following in `I-<site1>,<site2>` format.

- **Ch. Alias:** This column will contain the alias of the channel the activity took place on. For multisite data, this column will be empty. See note on aliases below.
- **Timestamp:** The date and time when the activity was received or originated. This will be the packet time stamp for packets that include a time stamp. Otherwise, it will be the date and time the packet was received by the input module.
- **Elapsed Time:** The duration of the activity. Only calls and busies provide an elapsed time.
- **System ID:** The system on which the activity originated.
- **System ID Alias:** The alias of the system on which the activity originated. See note on aliases below.
- **RFSS ID:** The RFSS on which the activity originated.
- **RFSS ID Alias:** The alias of the RFSS on which the activity originated. See note on aliases below.
- **Site ID:** The site on which the activity originated. For multisite data, if the activity is console-based, this column will contain the first (in numerical order) site of all sites involved in the activity.
- **Site ID Alias:** The alias of the site on which the activity originated. See note on aliases below.

Incapable sites are sites whose hardware could not support the call type; such as analog sites for digital calls.

Busy sites are sites that could not support a channel grant at the time of the call. This could be due to a lack of available channels.

You can view the details of an activity by double-clicking on an entry in the activity list. This will result in a dialog box showing every property that GenWatch3 knows about the selected activity. This functionality is also available in the Pause window.

Aliases (ID, Group, Target Radio ID, Supergroup, Channel, System ID, RFSS ID, and Site ID) can be changed in the GW_Alias GUI. If the alias has not been changed it will appear in the appropriate column using the respective GenWatch3 default GW$[ID], GW$[Group ID], GW$[System ID], etc. format alias.
Maximizing the Activity List
The GW_Activity GUI allows you to resize the activity list. To resize the activity list, follow the steps below:
1. Hover over the slider bar between the Packet Types list and the activity list. This will show a resize mouse pointer.
2. Hold down the left-click button and move the mouse left and right to resize the activity list.
3. You can also double-click on the slider bar to maximize the activity list and hide the Packet Types List. To show the Packet Types List again, double-click on the slider bar. This can also be done by checking/unchecking the Packet Types menu option under the Filter menu.

Customizing Channel Activity
The visual appearance of the data shown in the activity list can be customized in various ways. Features such as the font, font size, columns, column order, packet type colors, and more can be changed. These allow you to customize the look of the data to fit your needs.

Changing Activity List Font and Size
To change the font or size:
1. Click the Font menu option in the View menu. This will display the Font window.
   a. You can also right-click on the activity list and choose the Font menu option from the menu that appears.
2. Choose the Font, Font style (italic, bold, etc.), Font Size, among other options.
3. Click the OK button to apply the changes to the activity list.

Figure 1.2 – Font Window
Enabling/Disabling the Green Bar

Another feature that can be enabled is the **Green Bar**. When enabled, the background of the rows in the activity list is alternately colored green and white. This allows you to easily distinguish between consecutive packets and not confuse the data on adjacent lines. To enable/disable the **Green Bar**, either select the **Green Bar** menu option from the **View** menu or right-click anywhere on the activity list and select the **Green Bar** option from the menu that appears.

Notice that the Group and Radio ID columns may not change to the green background color. If a Group or Radio ID’s background color has been changed in the GW_Alias GUI, those colors assigned will be used instead. See the GW_Alias module book for more details on changing foreground and background colors for groups and radio IDs.

Showing/Hiding Columns

To select the visible columns in the activity list:

1. Click the **Select Columns** menu option under the **View** menu. This will display the **Select Columns** window.
   a. You can also right-click on the activity list and choose the **Select Columns** menu option from the menu that appears.
2. Check the columns you wish to see in the activity list. By default, all columns will be checked and thus will appear in the activity list.
3. Click the **OK** button to apply the changes to the activity list.

![Select Columns Window](image)
Reordering Columns
To change the location of a column:
1. Click the column header (column title) of the column you wish to move and hold the mouse button.
2. Drag to the left or right until you have reached the desired position. As the column is being dragged, the column you are currently over will be highlighted.
3. Release the mouse button when you have reached the desired position. The column you dragged will be placed at the position of the currently highlighted column. The highlighted column and all columns to its right will now be to the right of the dragged column. All those to the left will continue to be to the left.

Adding a Little Color to Your Life
To assign a color to a packet type, take the following steps:
1. Right-click on the packet type in the Packet Types list. This will result in a color dialog box.
2. Select the color that you wish to assign to the packet type.
3. Click OK. This will change the color of the selected packet type to the chosen color. All activities of this packet type in the activity list will also change to the selected color.

The Group and Radio ID columns do not change to the selected color. This is because these columns use the colors assigned to them in the GW_Alias GUI. See the GW_Alias module book for more details on changing foreground and background colors for groups and radio IDs.

Disabling Packet Throttling
By default, the GW_Activity module throttles packets to send a distinct input packet no more than once per second. For diagnostic purposes, a user that has the DisableThrottle privilege can disable this packet throttling. To enable/disable packet throttling check/uncheck the Throttle menu option in the Filter menu by clicking on that menu option.

This option has no effect on many multisite packets, as these packets are generally not sent in duplicate, triplicate, etc.

Throttling is used to reduce network bandwidth between the GW_Activity module and the GW_Activity GUI. When throttling is disabled, GW_Activity uses up to 10 times more network bandwidth.

Filtering Packet Types
The GW_Activity GUI contains a Packet Types list that shows all known packet types. This list will start off empty and will add new packet types as they are received by GenWatch3. New packets types will default to checked (Included) in the Packet Types list. All checked packet types will appear in the activity list as they are received. Packet types that are unchecked will not be shown in the activity list.
Packet Types

- Current Control Channel
- Scan Marker

**Figure 1.4 – Two Checked (Included) Packets**

**Selecting All Packet Types**
Click the Select All button to select all packet types in the list. This will show all activity for all known packet types.

**Unselecting All Packet Types**
Click the Unselect All button to unselect all packet types in the list. This will exclude all activity for all known packet types, thus stopping the scrolling activity.

**Deleting Packet Types**
Click on a packet type to select it, then press the Delete key to remove that packet type from the list. Holding the Shift key while pressing Delete will remove all packet types from the list. You can also click the Delete and Clear buttons under the Packet Types list.

Deleted packets will be re-added to the list with default colors the next time GW_Activity receives that type of packet.

**Figure 1.5 – Packet Types List Buttons**

**Suppressing Duplicate Packets**
This option allows you to filter out consecutive packets with very similar details. To be hidden, a packet must have the same type, ID, target ID, etc., as the previous packet. To enable/disable duplicate packets check/uncheck the Suppress Duplicates menu option in the Filter menu by clicking on that menu option.

This option has no effect on many multisite packets, as these packets are generally not sent in duplicate, triplicate, etc.
This chapter describes the advanced options available in the GW_Activity GUI.

This chapter contains the following sections:

- **Advanced Filters**: Describes how to filter packets by system ID, RFSS ID, site ID, group ID, radio ID and/or agency.
- **Pausing the Activity List**: Describes how to create an Activity Pause window and the Activity Pause window options.
- **Activity Details**: Describes how to view the detailed information for an activity.
**Advanced Filters**

The GW_Activity GUI, by default, accepts activity from all connected systems, RFSSs, sites, groups, radios, and agencies. The sections below describe how to filter the activity.

**Trunking Filters**

If you wish to filter the GW_Activity GUI based on Trunking Systems, click on the *Advanced* menu option of the *Filter* menu, then click on the *Trunking Filters*… menu option. This will load the Advanced Filters window.

The current state of any trunking filters is displayed in the menu bar. Clicking on this text will load the Advanced Filters window. If you have applied any filters in the Advanced Filters window, the menu bar will provide details on the types of active filters.

**System Filter**

This filter will allow the GW_Activity GUI to be filtered by System, RFSS and Site.

1. Click on the System tab.
2. Uncheck the nodes of the Systems, RFSSs and/or Sites that you wish to exclude. Filters are applied to the scrolling data as you check/uncheck nodes.
3. Click the OK button. This will return you to the GW_Activity GUI.

![Advanced Filters – System Tab](image)

**Figure 2.1 – Advanced Filters – System Tab**

This tree only contains system IDs, RFSS IDs and site IDs received by the GW_Activity GUI. This window does not reference the GenWatch3 Alias database for a list of these IDs.
For multisite systems, if activity contains a Site ID List and one of the sites in the Site ID List is marked as Allowed, GW_Activity will show this activity. You can see an activity’s Site ID List via the Activity Details window. See the Activity Details section below.

**Group Filter**

This filter will allow the GW_Activity GUI to be filtered by group.

1. Click on the **Groups** tab.
2. Click the **Filter Activity by Group** option.
3. Click the **Add** button to add one or more groups.
4. Click the **OK** button. This will apply your filter and return you to the GW_Activity GUI.

![Advanced Filters - Groups Tab](image)

**Figure 2.2** – Advanced Filters – Groups Tab
Radio ID Filter
This filter will allow the GW_Activity GUI to be filtered by radio ID.
1. Click on the Radio ID tab.
2. Click the Filter Activity by Radio option.
3. Click the Add button to add one or more radio IDs.
4. Click the OK button. This will apply your filter and return you to the GW_Activity GUI.

Figure 2.3 – Advanced Filters – Radio ID Tab

Agencies Filter
This filter will allow the GW_Activity GUI to be filtered by agencies.
1. Click on the Agencies tab.
2. Click the Filter Activity by Agency option.
3. Click the Add button to add one or more agencies.
4. Click the OK button. This will apply your filter and return you to the GW_Activity GUI.

Figure 2.4 – Advanced Filters – Agencies Tab
**Pausing the Activity List**

You may wish to pause the activity list to view a snapshot of activity data or to make double-clicking on an activity easier. To pause the activity list, click the **Pause** menu button. This will open an *Activity Pause* window that contains the data in the activity list at the time of the pause.

![Activity Pause Window](image)

**Figure 2.5** – Activity Pause Window
Pause Window Options

Opacity (available in menu only)
Opacity measures how close a window is to solid (not transparent). You can adjust the opacity of an Activity Pause window (making it more transparent) to allow you to see real-time activity while viewing the Activity Pause window.

Print (available in menu and right-click)
Prints the Activity Pause window. This window will print in a landscape format (longer horizontally than vertically). You may need to adjust the column widths of the Activity Pause window to print the desired data.

Select All… (available in right-click only)
Contains the following options for selecting like activity in the Activity Pause window.

- **Activities on the selected group**: Selects all activities with the same Group as the topmost selected activity.
- **Activities from the selected radio ID**: Selects all activities with the same ID as the topmost selected activity.
- **Activities of the selected type**: Selects all activities with the same Description and Type as the topmost selected activity.
- **Activities in the selected conversation**: Selects all activities within the same conversation as the topmost selected activity. This generally involves packets that share a common Conversation Number or Call Index.
**Activity Details**

Each activity shown in the GW_Activity GUI contains much more information than what is shown in the columns of the activity list. To view this additional information, double-click on the desired packet in either the main window or an *Activity Pause* window. This will show the *Packet Information* window, shown below.

![Packet Information Window](image)

*Figure 2.6 – Packet Information Window*